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Thank you for purchasing this JVC product.
This User’s Guide has been compiled in order to describe the
operating procedures for the product.
To enable a correct use of the product please read it carefully.
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<Precautions>
It is strictly prohibited to duplicate any part or the whole of this manual.
The contents of this manual may be subject to change without notice.
Take care not to violate the copyright of other persons.
JVC will not assume liabilities for damages incurred as a result of any error that occurs in this document.

<Trademark information>
Microsoft and Windows are the registered trademarks of the Microsoft Corporation in the USA and other countries.
Any other company names or brand names that appear in this manual are the trademarks or registered trademarks of
their respective owners. Note that this manual omits markings indicating registered trademarks, trademarks and
copyrights.

<Before recording and storing image materials>
Copyright law prohibits the use without the permission of the copyright owners of the recording or storage of image reproduc-
tions such as TV broadcasts or prerecorded materials or of publications such as posters, except for personal use.
Before recording important images, be sure to perform a test recording to ensure that a proper recording and reproduc-
tion is enabled. Also, please confirm the available HDD capacity.
JVC will not assume liability for any damage incurred by a failure to properly record or playback that may have been
caused by any defects in this application or computer software.

<Compatibility with VN-S200U>
On the VN-S400U, it is possible to playback REC files recorded by VN-S200U/S100U.
On the VN-S400U, it is not permitted to open Work Spaces created by VN-S200U/S100U.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).
This product includes software written by Eric Young (eay@cryptsoft.com).
This software is based in part on the work of the Independent JPEG Group.
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This User’s Guide describes the operating procedures of the VN-S400U. For the installation and activation setup of
the VN-S400U, refer to the separate instructions. For the operating environment and compatible models of VN-S400U,
refer to the “General Information“ sheet attached to the package. Visit our website to confirm the current information
about this version. (URL is addressed under the separate instructions.)

1-1. Main Functions of the VN-S400U
1. Multi-Viewing

Simultaneous connection to multiple devices.
Simultaneous viewing of up to 16 devices.

2. Record / Playback
Recording the images from the connected devices being viewed and playing it back later.
Timer recordings.

3. Snap Shot
Saving still images in a desired folder.

4. Alarm processing
Setting of the method of notification on receiving an alarm from a connected device.

5. Camera control and external device control
Panning / tilting / zooming / of connected cameras.
Control of the devices connected to the serial ports of the VN-A1U or DM-NC40U.

1-2. Differences of the previous version
Work Space compatibility with older versions
Work Space files (.vxw) created by Ver.1 or Ver.2 are available at Ver.3. The Work Space files of Ver.1 or Ver.2
are converted automatically to the Ver.3 format  when they are saved at Ver.3.
It is not permitted to use the Work Space files of Ver.3 format at Ver.1 or Ver.2.

The file format for automatic deletion
With Ver.2, *.rec, *.asf, *.jpg, *.bmp and *.avi format images are deleted automatically depending on the [Save
Period] and [disk full] settings at [Option] dialog box. To keep these format files without deletion, save them to
a folder other than the place specified at the [Rec] tab of [Live View Window Setup] dialog box. See ‘12-5
Setting the Recording File Save Period’ for the setting procedure of [Save Period] and [Disk full] at [Option]
dialog box, and see ‘13-8 Setting the Recording File Save Location’ for the setting procedure of saving folder at
[Live view Window Setup] dialog box.

New functions added at Ver.3
1. Exclusive Registration Mode (Page 13)
2. Protect Mode (Page 31)
3. DM-NC40U MPEG-4 TCP mode (Page 43)
4. V.Networks JPEG Frame rate setting (Page 43)
5. DM-NC40U PinP setting (Page 44)
6. VN-C30U JPEG Multicasting (Page 45)
7. VN-C10U High Gain mode (Page 46)
8. DM-NC40U External device control setting (Page 47)
9. Up to 20 patterns available for View Windows (Page 49)

1. Introduction
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2-1. Glossary
Before operating the VN-S400U, please confirm the meaning of the special terms used in this User’s Guide.

Work Space;
The VN-S400U saves the information on the connected devices and on various settings in files called Work Space
files (*.vxw).

View Window;
This window is used to display the images from the connected devices (cameras and encoders) or play back the
images previously recorded in the image files. The Work Space can display more than one View Window simulta-
neously.
A View Window for displaying the images from connected devices is referred to as a Live View Window, and a View
Window for displaying the images saved in the image files is referred to as a Play View Window.
The user can set the display size and position of each View Window.

View Point;
The devices connected to the network (cameras and encoders) are generically called the View Points.
Each View Point has a unique IP address.

View Channel;
The image output channel from each View Point is referred to as the View Channel. It is the image from the View
Channel that is displayed on the View Window. As one View Point usually has only one image output channel, each
View Point has one View Channel.
The View Channel includes the JPEG View Channel and the MPEG-4 View Channel. The image from a JPEG View
Channel can be displayed simultaneously on multiple View Windows. (DM-NC40U has two View Channels; MPEG-4
View Channel and JPEG View Channel, both of the channels can be displayed on the VN-S400U at a time. VN-C10U
also has two View Channels; MPEG-4 View Channel and JPEG View Channel, one channel can be displayed on the
VN-S400U at a time depending on the setting of  VN-C10U. In this User’s Guide, “MPEG-4 View Channel” is referred
as “MPEG channel” and “JPEG View Channel” is referred as “JPEG channel” as the case may be.)

2. VN-S400U Startup



7

Open the Windows [Start] menu, select [Programs] and then the [JVC] folder, and click on [VN-S400U] to start the
program. (The VN-S400U program can also be started by double-clicking on the VN-S400U icon on the desktop.)

The Main Window appears at the startup. As the Work Space is not yet opened, the Main Window appears blank
at this moment.

2-2. Starting the VN-S400U

(Main Window  after a Work Space is opened and
Play View Window “PlayView1” is displayed.)

[Title bar]
Shows the file name of the opened Work Space.

[Menu bar]
Shows the menus required for the operation of the VN-S400U.

[Toolbar]
Shows the function icons. The toolbar can be displayed or hidden by clicking on [Toolbar] in the [Display] menu.

[View Window Area]
This area shows the View Windows.

[Tree View Area Layout]
This area shows the icons of the registered View Windows and View Points. The Tree View Area Layout can be
displayed or hidden by clicking on [Tree View Area] in the [Display] menu.

[Controller Area]
This area shows the controller for use in controlling the images, cameras and external devices. The Controller
Area can be displayed or hidden by clicking on [Controller Area] in the [Display] menu.

View Window area

Tree View Area Layout

Controller area

Title bar

Toolbar

Menu bar
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In the following, let us start the VN-S400U and try some of the basic operations.

<< Connecting to View Point and Displaying the Image>>

Start the VN-S400U.
Open the Windows [Start] menu, select [Programs] and then the [JVC]
folder, and click on [VN-S400U] to start the program. (The VN-S400U
program can also be started by double-clicking on the VN-S400U icon
on the desktop.)

Create a new Work Space.
Open the [File] menu and select [New Work Space].
When the ‘New Work Space’ dialog box appears, enter the name of
the new Work Space within 32 characters and click on [OK].

Register the Live View Window.
Open the [Insert] menu and select [Live View Window].
‘New View Window’ dialog box appears, enter the name of the new
View Window within 32 characters and click [Register].
A Live View Window appears and the icon for the Live View Window is
added in the Tree View Area Layout.

Register a View Point.
Open the [Insert] menu and select [View Point].
The [New View Point] dialog box appears.
Enter the IP address and the name of the View Point within 32 char-
acters.
For the [View Point Type], select [Auto] in usual use.(Select [Un-
known] if the device of View Point is not in connectable condition. In
this case, this View Point is connected automatically when the Work
Space is opened next time.)
After completing the entries, click on [Register].

The icons for the View Point and its View Channel are added in
the View Point display section of the Tree View Area Layout.

3. Let’s Try

1

2

3

4

[New Work Space] dialog box

[New Live View Window] dialog box

Tree View area Layout

[New View Point] dialog box

Tree View area Layout



9

View an image
Click on a View Channel icon or View Point icon in the View Point
display section in the Tree View Area Layout to select a View Chan-
nel or View Point. Then drag & drop the icon in the Live View Win-
dow to view the image input from the View Channel.

<< Recording the image of a View Channel >>
Record the image.
Click on the [Rec] button in the live view controller to start recording.
The Live View Window displays "REC" during recording.

Stop recording. Click on the [Stop] button in the live view controller to
stop recording.

<< Playing back the recorded image >>
Display the list of recorded image files.
Click on the [W] tab in the Tree View Area Layout.
Click on [+] of the recorded Live View Window icon to expand it,
and then click on [+] of the "info" icon to expand it, and click on the
[PC REC File] icon.
The list of recorded image files will be displayed in the right half of
the Tree View Area Layout. (The folder list will be shown if the View
Point is DM-NC40U). The names of the image files are provided
automatically according to the date and time of the start of record-
ing.

Play back the image of the selected image file.
Double-click on the name of the desired file in the list to start play-
back in the Play View Window.

Stop playback.
Click on the [Stop] button of the playback controller.

The VN-S400U can connect to multiple View Points and display the im-
ages of their View Channels by displaying their View Windows in a Work
Space by using the above steps. For details of these operations, see the
respective descriptions in this manual.

7

6

5

8

9

10

Drag & drop the icon to the Live View Window

Live Controller

Tree View area Layout  [W] tab

List of recorded image files
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This chapter describes how to display the image from a View Channel in the Live View Window.

4-1. Crating a New Work space

Open the [File] menu and click on [New Work Space].
The dialog box for registration of a new Work Space appears.

[Work Space Name]
Enter the Work Space Name within 32 characters.
[Path]
Specify the location for saving the Work Space file. The loca-
tion can be selected by clicking on [Browse] to open a folder
browsing dialog box. Set the local drive as the saving place of the
Work Space. It may malfunction by setting the network drives as
the saving place.
[Set Template]
The template facility is convenient for creating a new Work Space
by copying the View Window and View Point setup of a previ-
ously saved Work Space. When checking ‘Set Template’ in this
dialog box, the previously saved Work Space may be specified
for use as the template of the new Work Space. (The Work
Space for use as the template can also be selected by clicking
[Select] to open the ‘Open’ dialog box.)

Click on [OK] to display the new Work Space.

4. Image Viewing (Live Image Viewing)

2

1
[New Work Space] dialog box



11

4-2. Opening a Live View Window

4-3. Registering a View Point

Click to change the View Window name.
(When the lower directory level is not displayed as
shown in the figure, it can be displayed by clicking
on the [+] at the left of the icon.)

Open the [Insert] menu and click on [Live View Window].

‘New Live View Window’ dialog box appears, enter the name of
the new View Window within 32 characters and click [Register].

A Live View Window appears and the icon for the Live View
Window is added in the Tree View Area Layout.
Up to 16 View Windows may be registered using the same pro-
cedure as above.

Open the [Insert] menu and click on [View Point].
The [New View Point] dialog box appears.

[IP Address]
Enter the IP address of the View Point (connected device to be
registered).
[Multi Register]
View Points having continuous IP addresses can be registered
by one time. Check [Multi Resister] and enter the starting IP
address and ending IP address in the [IP Address] boxes.
[View Point Name]
The name of a View Point being handled on the VN-S400U can
be decided as required within 32 characters.
[View Point Type]
Select [Auto] in usual use. Select [Unknown] if the device of
View Point is not in connectable condition. In this case, this View
Point will be connected automatically when the Work Space is
opened next time.)

Click on [Register] to register the selected View Point. The icons
for the View Point and the View Channel are added in the view
point display section of the Tree View Area Layout.

Up to 256 View Points may be registered using the same proce-
dure as above.

View Point
View Channel

1
2

1

2

[New Live View Window] dialog box

Tree View Area Layout

[New View Point] dialog box

Tree View Area Layout
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4-4. Viewing the Image of a View Point

Condition in which three View Channels may be
registered for viewing in a single View Window.

Images from the View Channels can be viewed in the Live View Window.

[ Viewing the image of a View Channel by dragging & dropping its icon ]
Select the View Point icon or the View Channel icon in the Tree View Area
Layout, and drag & drop it directly to the Live View Window to view the
image. (Drag & drop the View Channel icon if the View Point is DM-NC40U.)

* It is not permitted to register a single View Channel more than once in a Live View Window.
* It is not permitted to register both of MPEG-4 View Channel and JPEG View Channel in a Live View Window.
* It is not permitted to register plural number of MPEG-4 View Channels in a Live View Window.
* One MPEG-4 View Channel can be registered in a Live View Window.

[ Viewing the image of another View Channel ]
To view the image of another registered View Channel, exit from the se-
quential display mode and use the View Channel selection facility of the
live controller. (If the sequential display mode is set, the registered View
Channels are displayed by switching them one after another. See section
13-3, "Setting the Sequential Interval" for the sequential display function
and refer to the section 5-1, "Using the Live Controller" for details of the live
controller.

The image of a View Point can also be viewed by dragging and dropping
the View Point icon or the View Channel icon in the position of the Live
View Window icon inside the Tree View Area Layout.
Up to 16 View Channels can be registered for viewing in a Live View Win-
dow by repeating the above procedure.

Drag & drop the icon to the Live View Window

Tree View Area Layout

Drag & drop the View Channel icon to the Live
View Window icon.
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4-6. Output the Sound of All View Windows
If [Mixing All View Window’s Sound] of [Setting] menu is checked, the
sound of all View Windows are output. Click to remove the check mark
of this menu so that the sound of the active View Widow may be output.
Use the respective live view controller or playback controller to control
the sound of each View Window. See section 5-1, “Using the Live Con-
troller” or section 9-1, “Using the Playback Controller” for details of the
sound control.

4-5. Exclusive Registration Mode
In the exclusive registration mode, one View Channel is asigned to one
Live View Window. The View Channel which has been registered the Live
View Window originally is disconnected and deleted when another View
Channel is registered there.
Click [Exclusive Registration Mode] from [Setting] menu to make the ex-
clusive registration mode effective. The mode is effective if a check mark is
put beside it. Click [Exclusive Registration Mode] from [Setting] menu
again to release it.

[Setting] menu

[Setting] menu
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5-1. Using the Live Controller

View Channel selection

5. Control of a Live image

This chapter describes how to use the controllers for controlling and viewing the images from the connected View
Point devices in the desired order. The type of the displayed controller varies according to the connected View
Point device model.

To display the controller, click and activate the View Window connected to the View Point of the desired controller.

The following procedures of the Live Controller are common to all Live
View Windows regardless of the connected View Point device models.

[Title Bar]
This shows the name of the active View Window. A drop-down list is
provided to allow the selection of a different View Window name.

[Open file button]
‘Open’ dialog box appears. Choose a file to playback it.

[Stop]
Click on this button to stop the live image recording.

[Rec]
Click on this button to start the live image recording. To stop recording,
click on the [Stop] button.

[Snap Shot]
Click on this button to save the image in the form of a still image. (See
chapter 10, "Snap Shot" for the snap shot function.)

[Sequential Display]
Click on this button to enter or exit the sequential display mode. (See
section 13-3, "Setting the Sequential Interval" for the sequential display
function.)

[Muting]        (Controllable when the live image includes the sound)
Click on this button to mute the View Window. This button is green
during the muting. Click it again to output the sound.

[Volume control] (Controllable when the live image includes the sound)
Drag the marker to the left to turn down the volume, or to the right to turn
up the volume.

[View Channel Selection]
The View Channel to be viewed can be selected here. (This area is
effective only if the sequential display is in the stop mode.)

Title Bar Volume Control

Live Controller
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Point the camera to the desired position by adjusting the [Camera
Control] box.

Right-click on the desired one of the [Position Memory] but-tons 1
to 10 (or 1 to 6 with the VN-C2U) and then click on [Memory]. The
position is now registered in the memory.

Henceforth, clicking on the [Position Memory] button points the
camera to the position registered under the button and the re-
quired image is displayed in the View Window.

To change a previously registered position memory setting under
a button, point the camera to a new position, right-click on the
same button and right-click on [Memory].

[Position Display]
Shows the current pan/tilt position and zoom setting.

[Pan Tilt Step]
Used to set the panning/tilting angle per click.

[Tele Single-Step Button]
Each click on the button zooms into the image.
(This function is disabled in case the View Point is VN-C2U.)

[Wide Single-Step Button]
Each click on the button zooms out of the image.
(This function is disabled in case the View Point is VN-C2U.)

[Pan/Tilt Adjustment Buttons]
Arrow buttons are provided to control the pan/tilt position
of the camera.
The panning/tilting angle per click can be set in the [Pan Tilt Step].

[Zoom Slider]
Dragging the mouse on this control adjusts the zoom ratio.
(This function is disabled in case the View Point is VN-C2U.)

[Position Memory]
Clicking on one of the buttons points the camera to the previously
registered position. (See section 5-3, "Setting the Position Memory"
below for the method of setting the position memory positions.)

5-2. VN-C2U / C3U / C30U Controller

5-3. Setting the Position Memory

Position display
Pan/Tilt adjustment

Zoom Slider and
Tele/wide single-step button

When a connected View Point device is one of the models mentioned above, the [Camera Control] box is displayed
below the live controller.

The position memory function enables registration of the pan/tilt/zoom adjustment positions in the memory. Up to 10
positions (or 6 positions with the VN-C2U) can be registered in the memory.

Camera control

Position Memory

1
2

3

4
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5-4. External Device Controller
When the VN-A1U or DM-NC40U is connected to a View Point, the external devices connected with VN-A1U or DM-
NC40U can be controlled on VN-S400U. Refer to section 15-7, “Setting an External Device” and choose the external
device to control.
The external device controller is displayed below the live controller. The external device connected with VN-A1U can
be controlled through this external device controller.
(The type of the external device controller varies according to the connected device.)

To use the external device controller, it is needed to install the controller (External Device Controller Package [VN-
SE400U] of each external device.
For the installation, please access (http://www.jvc-victor.co.jp/english/pro/vnetworks/support/index.html)
and download the installers of each controller.

In control of the external device, Administrator authority of the external device is required.



17

6-1. Recording and Using the Live Controller

6-2. Deleting a Recorded File
The recorded files are saved with the file names of either "<Recording start date/time>.rec" or "<Recording start date/
time>.asf".It is possible to delete a recorded file by adopting the following procedure.

Click on the [W] tab in the Tree View Area Layout.

Click on the [PC REC File] icon under the Live View Window of
the recorded image to display the list of image recorded files
at the right-hand side of the Tree View Area Layout.

Select the file to be deleted from the list and press the [Delete]
key.

<< CAUTION >>
A recorded file cannot be restored once it has been deleted. Be sure
to check the recorded image contents before deleting. JVC will not
assume liability for the loss of image files due to accidental erasure.

List of recorded image files

6. Recording an Image from a View Channel

The image being displayed in the View Window can be saved in the PC.
Recording is performed on a per-window basis. The save destination folder is the folder displayed in the [Rec Path]
under the [Rec] tab in the [Live View Window Setting] dialog box. It can be displayed by opening the [Setting]
menu and selecting [View Window]. By default, the save destination folder name is <Folder in which the Work
Space is created>\<Work space name>\<View window name>.
e.g.; C:\Program Files\JVC\VN-S400U\Your Work Space\View Window1
When recording is stopped a file with a name such as ***.rec (when the View Channel is a JPEG channel) or ***.asf
(when the View Channel is an MPEG-4 channel) is created in the disk.
The file name section "***" consists of 14 characters representing the (y) year, (m) month, (d) day, (h) hour, (m)
minute and (s) second of the start of the recording in the “yyyymmddhhmmss” format.
Recording files are created separately by an hour.

In order to make the window active, click on the View Window of
the image to be recorded among those being displayed.

Make sure that the selected View Window name is shown on the
title bar of the live controller, and click on the [Rec] button.
If the controller area is not being displayed, display it by opening
the [Display] menu and clicking on [Controller].

Recording starts.

To stop recording, click on the [Stop] button.

Title Bar

1
2

3
4

1
2

3

Live Controller

Tree View Area Layout  [W] tab
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7. Timer Recording
The timer recording starts and stops recording automatically at the preset time of the day.

Among the Live View Windows being displayed, click on the Live
View Window of the image to be subject to timer recording
to make the Window active.

Open the [Setting] menu and select [View Window] to display the
‘Live View Window Setting’ menu.

Select the name of the Live View Window to be subjected to timer
recording from the list, and click on the [Timer Rec] tab.

Click on the check boxes of the desired timer programs (1 to 7).
This makes it possible to enter the timer recording time.

Enter the [Start Time] and [End Time] of the timer recording in the
24-hour system.
(An End Time of 0:00:00 means the recording until the end of the
day. Note that it is not permitted to set a timer recording over a
period of two days.)
In [Schedule], select one of either [Everyday] or a day from be-
tween [Every Sunday] to [Every Saturday].

Click on [OK] to close the ‘Live View Window Setting’ dialog box.

<< CAUTION >>
To execute a timer recording, the VN-S400U should be running at
the recording start time.

5

1

2
3
4

[Timer Rec] tab

[Live View Window Setting] dialog box
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8-1. Playing Back a PC Recorded File

Double-click on the file name to be played back.

8. Playback of a recording
The VN-S400U can play back the image files recorded from View Channels as well as the image files recorded in the
memory (CF card, etc.) of the View Points on the View Windows.
The playback image is displayed in one of the Play View Windows that are preregistered in the Work Space.
(A total of four Play View Windows, [PlayView1] to [PlayView4], are pre-registered in the Work Space. It is not
permitted to register an additional Play View Window or delete any of the pre-registered Play View Windows.)

This function plays back a PC file saving the image of a View Channel.

Click on the [W] tab in the Tree View Area Layout.

Click on the [PC REC File] icon below the name of the Live View
Window used to record the image.

The list of the image files using the Live View Window is shown at
the right-hand side of the Tree View Area Layout.
If the recorded image file is ASF, the ∗ mark is displayed with the
‘Time’ information.
(e.g.)  ∗2003/04/13 20:29:23 - ∗20:29:53

If there are image files more than 1000, the list is shown as follows;
- The entire information is displayed in black even if it has the alarm information.
- The ∗ mark is displayed with the ‘Time’ information without the time of ending the recording.
   (e.g.)  ∗2003/04/13 20:29:23

If the ∗ mark is displayed with the ‘Time’ information, the time stamp information of the file is displayed in the ‘Time’.
This means that the ‘Time’ may be different from the actual time the file has been recorded.

The file list can be rearranged by clicking on the item name that is required as a reference for rearrangement. In case
that there are many files for the rearrangement, it may sometimes delay the performances of starting or
stopping recording on the VN-S400U while the rearrangement of the files.

Double-click on the file to be played back. This starts playback of the file in the first Play View Window (PlayView1).
It is also possible to start playback by dragging & dropping the file name to the desired Play View Window directly,
or to the Play View Window icon at the left-hand side of the Tree View Layout.

5
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Tree View Are Layout  [W] tab
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Click on the [P] tab in the Tree View Area Layout, or double-
click [LOCAL REC File] icon to make the [P] tab come to the
front.

Click on the [LOCAL REC File] icon below the name of the
View Point saving the desired image file.

Click on the [Get File List] button.

The list of the image files saved in the View Point is shown at
the right-hand side of the Tree View Area Layout.

The local file list can be rearranged by clicking on the item
name that is required as a reference for rearrangement.
In case that there are many files for the rearrangement, it may
sometimes delay the performances of starting or stopping re-
cording on the VN-S400U while the rearrangement of the files.

Double-click on the file to be played back. This starts play-
back of the file in the first Play View Window  (PlayView1).
It is also possible to start playback by dragging & dropping
the file name to the desired Play View Window directly.

If it is required to copy the local recording file in the PC, select
the file and click on the [Copy File] button.

When the ‘File Trans’ dialog box appears, choose the file for-
mat and the saving place (Path), and click on [OK].

8-2. Playing Back a Local Recorded File
This function plays back an image file saved in the local memory (CF card, etc.) of a View Point.
(This function is available for only VN-C10U or VN-A1 attached with a CF card. DM-NC40U is unavailable.)
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Tree View Are Layout  [P] tab

[Get File List] button

[Copy File] button

List of image files
(Double click on a file name to
playback it.)
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9-1. Using the Playback Controller
Title bar

File name display

Time code display

Playback position
slider

9. Control of a Playback Image
This chapter describes how to use the controller for controlling the image being played back.
To display the playback controller, click and activate the View Window connected to the View Point of the desired
controller.

[Title bar]
Shows the name of the active Play View Window. The
active View Window can be changed by selecting its
name from the list.

[Open file button]
‘Open’ dialog box appears. Choose a file to playback it.

[File name display]
Shows the file name being played.

[Time codes display]
Shows the time codes in the following order and from
the left to the right: Start frame, frame being played back
and End frame.

[IN point button] (For only REC files)
Click on this button to specify the IN point for clipping
a file. (For clipping and saving an image file, see sec-
tion 9-2, "Clipping and Saving a File.")

[OUT point button] (For only REC files)
Click on this button to specify the OUT point for clip-
ping a file. (For clipping and saving an image file, see
section 9-2, "Clipping and Saving a File.")

[Playback position slider]
Shows the position being played back. The play-
back position skips by clicking on the slider. Drag
the marker to seek a position in the image.

[Fast Rewind]
Click on this button to rewind. It is rewound faster by
clicking this button during rewinding, and click again
to return the rewinding speed to normal.

[Fast Forward]
Click on this button to fast-forward. It is fast-for-
warded faster by clicking this button during fast-
forwarding, and click again to return the fast-for-
warding speed to normal.

[Frame Backward]
At REC file:Returns the image by one frame.
At ASF file:Returns the image by 30 milliseconds.

[Frame Advance]
At REC file:Advances the image by one frame.
At ASF file:Advances the image by 30 milliseconds.

[Muting]
(Controllable when the live image includes the sound.)
Click on this button to mute the View Window.
This button is green during the muting. Click it again
to output the sound.

[Volume control]
(Controllable when the live image includes the sound.)
Drag the marker to the left to turn down the vol-
ume, or to the right to turn up the volume.

[Stop]
Click on this button to stop playing back the image.

[Play]
Click on this button to start playing back the image.

[Pause]
Click on this button to temporarily pause the im-
age playback.

[Snap Shot]
Click on this button to save the image in the form
of a still image. (For the snap shot function, see
chapter 10, "Snap Shot.")

[Save As] (For only REC files)
Click on this button to save the file as another name.
When the IN and OUT points are specified, the
clipping image is saved as another name.  It is
possible to choose the saving format from REC or
AVI, but AVI format is not available for playing back
at the VN-S400U.

[View Channel Selection]
The View Channel of the recorded file to be viewed
can be selected here. Select [select All] to play-
back all channels. (This area is effective only if the
playback file is recorded by sequential display
mode.)

View Channel
          selection

Volume control

Playback controller
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9-2. Saving a File as Another Name (For only REC files)

Time code of the IN point Time code of the OUT point

A REC file being played back can be saved as another name. It is also possible to clip the REC file by specifing the
starting point (IN point) and the ending point (OUT point), and save the clipped section as a separated file.
(It is impossible to clip and save an ASF file (*.asf) which is created when the View Channel is an MPEG-4 channel.)

Play back the REC file to be saved as another name.

While viewing the playback image, click on the [IN] button at the
desired point to specify it as the IN point.

While viewing the playback image, click on the [OUT] button at
the desired point to specify it as the OUT point.

To modify a previously specified IN or OUT point, click on the [IN]
or [OUT] button at the desired point.
The clipped image can be confirmed using the [Frame Backward]
and [Frame Advance] buttons as well as the playback position
slider. The time codes of the IN and OUT points are shown in the
time code display area.
If the IN point is set to the beginning of this REC file and OUT point
is set to the ending of it, it means that this REC file saved as
another name without clipping.

Click on the [Save As] button.

When the [Save As] dialog box appears, specify the file name and
save location, choose the file type from REC (*.rec) or AVI (*.avi),
but AVI format is not available for playing back at the VN-S400U.
Click on the [Save] button to save it.

* If you save the image as AVI format, the inverted image is saved if the camera (View Point) is in the upside-down mode.
* The REC file is played back with keeping its frame intervals equal if there are some fluctuations of the frame rate in the
  REC file.
* It is not permitted occasionally to save the REC file by AVI format if the original REC file includes the images from different kinds
  of cameras between the IN point and OUT point on the file such as the recording of sequential displaying. To save the file by AVI
  format, choose one View Channel including the image to be saved by AVI at the View Channel Selection before the saving.
* The AVI files can not be played back by VN-S400U. Use other viewer such as Windows Media Player to playback the saved AVI files.

View Channel Selection

6
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[Snap Shot] window

10. Snap Shot
The snap shot function saves the image in the active View Window in the form of a still image file.
In case of the JPEG channel, the still images can be saved in JPEG files (*.jpg) or BMP files (*.bmp). In case of
the MPEG-4 channel, the still images can be saved in BMP files (*.bmp).
Up to 16 snap shot images can be displayed at a time.

Click on the View Window that shows the image as a snap shot in
order to make the window active.

Click on the [Snap Shot] button of the controller.

A separate [Snap Shot] window appears showing the still image.

The displayed still image can be magnified by opening the [Display]
menu of the [Snap Shot] window and selecting [Original Size]. (The
image cannot be magnified if its original size is 160 x 120.)
Up to 16 snap shots can be displayed simultaneously using the
same procedure.

In each [Snap Shot] window, open the [File] menu and select [Save
As].

When the [Save As] dialog box appears, specify the file name and the save location, and then click on the [Save]
button.
* Please note when the Snap Shot is saved as a JPEG file.

- The image is saved upside down if the Upside Down setting is effective in the View Point.
- An oblong image is saved if the View Point is VN-C30U.

To close the [Snap Shot] window without saving the snap shot, simply click on [X] at the top right corner of the
window.

<< CAUTION >>
* Saved snap shot files cannot be viewed on the VN-S400U. Please use another image viewer.
* If the Live View Window is hidden, the Snapshot picture is not the image of the Snap Shot button is clicked.
  In this case, it is shown as a Snap Shot that the image of the Live View Window displayed last time.
  To make the Snap Shot exactly, display the Live View Window when you click the Snap Shot button.

4
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Playback controller
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11. Alarm Setup
This chapter describes how to set up the operations to be executed upon receiving an alarm signal.
(To use this function, it is required to specify the port number for receiving alarm and to set up on the device
connected to the desired View Point in advance. See the section 15-4, “Setting the Connection Port” about the port
number, and refer to the instruction manual about the setting on the connected device.)

11-1. Alarm Setting Procedure

Click on the Live View Window to set up the alarm to make the
window active.

Open the [Setting] menu and select [View Window] to open the
‘Live View Window Setting’ dialog box.

Click on [Alarm Common] tab.

Click on the button of the [Target View Point] box to open the
drop-down list and select the View Point where the alarm opera
tion is required.

* If [Disabled] is selected, the alarm is not accepted.

Under the [Alarm 1], [Alarm 2], [Alarm 3/Motion Detect] and [Alarm
4/Relay Alarm] tabs, select the operations to be ex
ecuted upon reception of each alarm signal.

Check the boxes of the required operations.
(For the detailed operation setting, see the next section 11-2,
"Setting the Operation Upon Alarm Reception.")

* In case of DM-NC40U, only the first alarm signal is sent to VN-
S400U from the DM-NC40U if it catches some alarm signals continu-
ously at the same input pin within one second.

5
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[Alarm Common] tab

[Live View Window Setting] dialog box

(e.g.) [Alarm 1] tab

[Live View Window Setting] dialog box
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11-2. Setting the Operation Upon Alarm Reception

[Snapshot]
The image of the View Window is captured and saved as a picture file of JPEG format (JPEG View Channel) or BMP
format (MPEG-4 View Channel). The picture file is saved in the folder specified at the View Window Setting dialog box.
See the section 13-8, “Setting the Recording File Saving Location” for the procedure of changing the saving location. The
picture files are provided their file names automatically such as; [View Point name] + [Date and time]
(e.g.) ViewPoint-1_20030920192030.jpg  (Captured on 19:20:30, Sep.20, 2003, at the ViewPoint-1.)

* VN-S400U may records an image seconds later than the actual time of the alarm has reached, depending on the CPU load and the reliability
  of the network.
* In case that VN-S400U receives the images from cameras by a low frame rate such as 1/30fps, VN-S400U may records an image from
  seconds to tens of seconds earlier than the actual time of the alarm has reached. To improve this inconvenience, uprate the frame rate of

  transfering the image from cameras or uprate it temporarily at the "Change Frame Rate" box by "Start Rec"setting on this dialog box.

[Start Rec]
The image in the View Window starts to be recorded.

If [Rec Auto Stop] is checked, the recording of the View Window stops after the time specified in this field has elapsed.
If the View Point is in uni-cast mode of the JPEG channel, [Change Frame Rate] setting is available with the    [Rec Auto
Stop] setting. Choose the frame rate from 1 to 30 at the list.

* A larger frame rate makes the motion in the image smoother, but then the file size becomes larger.
* During the sequential displaying, only the frame rate of alarmed View Point’s image is changed to this frame rate setting. The frame rate of
  the image is depending on the casting ability of each View Point.
* The most highest frame rate is prioritized at the recording with some parts doubled when the several View Windows receive an alarm from
  the same View Point and record the image.
* This frame rate affects the other View Windows when they receive an alarm from the same View Point and record or display the image.
* VN-S400U may starts recording seconds later than the actual time of the alarm has reached, depending on the CPU load and the reliability
  of the network.
* In case that VN-S400U receives the images from cameras by a low frame rate such as 1/30fps, VN-S400U may not records images normaly by
  alarms. To improve this inconvenience, uprate the frame rate of transfering the image from cameras or uprate it temporarily at the "Change Frame
  Rate" box by "Start Rec" setting on this dialog box.

[Stop Rec]
The recording of the View Window is stopped.

[Online]
The corresponding View Window is displayed even if it is hidden.

[Highlight]
The corresponding View Window is displayed if it is hidden, and stop sequential displaying to display the alarmed image.

If [Highlight View Window] is checked, the View Window is enhanced using a color frame. (For the frame color setting,
see chapter 12, "Option Setup.")

If the [Change View Window] is checked, the View Window is displayed in the position and size set in this field.
Position: Left Top (The View Window is moved to the top left of the View Window area.)

Not Move (The View Window display position is not changed.)
Size: [160x120] [320x240] [640x480] (The View Window size is changed to selected size.)

Detailed settings for [Start Rec]

Detailed settings for [Highlight]
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[Message]
The message entered in the text box is displayed.

Display:  View Window (The message is shown on the View Window, and it is cleared by click on the View Window.)
     Pop Up (The message is displayed as a pop-up message. Pop-up messages are displayed up to 32 on

                             the screen.)
Message Text: Enter the message within 64 characters to be displayed in this text box.
Prioritize the message attached alarm: If checked, the alarm message from the DM-NC40U is displayed by
priority.(Some messages possibly can not be displayed all of the characters if it is too longer. )

[Wave File Playback]
The wave file specified in this field is played back.
Specify the wave file in the text box.

[Program Execution]
The program specified in this field is run.
Specify the program file in the text box.

[E-mail Notice]
E-mail messages are sent to the address specified in this field.
(For modification of the address, see section 12-7, "Setting the E-Mail Sending Address Upon Alarm Reception.")

<< NOTE >>
As playing back a wave file with a large file size may slow down the
operation depending on the PC performance capability, it is recom-
mended to specify a wave file with as small a size as possible.

<< NOTE >>
As running a program file with a large file size may slow down the
operation depending on the PC performance capability, it is recom-
mended to specify a wave file with as small a size as possible.

Specify the contents of the E-mail.
Information:
Message ...................................... The message set for [Message] is entered in the E-mail text.
View Point Name (IP Address) .... The View Point name and its IP address are entered in the E-mail text.
Alarm Type .................................. The alarm type and alarm number 1 to 4 are entered in the E-mail text.
Time ............................................ The time of alarm reception is entered in the E-mail text.
Attachment:
If [Snap Shot] is checked, the snap shot at the moment of alarm reception is captured as a JPEG file and attached
to the E-mail.

Detailed settings for [Wave File Playback]

Detailed settings for [Program Execution]

Detailed settings for [Message]

Detailed settings for [E-Mail Notice]
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12-2. Showing / Hiding the IP addresses
Click on the [Display] tab in the [Option] dialog box.

[IP address]
Displays or hides the IP address of the View Point icon and the Live
View Window.
(If this setting is changed during recording, the View Channel will be
recognized as another view channel in its playback.)

12-3. Highlighting the View Window
Click on the [Display] tab in the [Option] dialog box.

[Highlight Frame]
If checked, a frame is displayed around the active View Window.

[Thickness]
Specify the line thickness of the frame around the active View
Window.

[Active Frame Color]
Specify the color of the frame around the active View Window.

[Alarm 1]
Specify the color of the frame around the View Window receiving
Alarm 1.
(To display a color frame around a View Window receiving an alarm,
it is required to select [Highlight] in section 11-2, "Setting the Opera-
tion Upon Alarm Reception" and specify enhancement of the View
Window.)

[Alarm 2]
Specify the color of the frame around the View Window receiving
Alarm 2.
(To display a color frame around a View Window receiving an alarm,
it is required to select [Highlight] in section 11-2, "Setting the Opera-
tion Upon Alarm Reception" and specify enhancement of the View
Window.)

12-1. Setting the Tree View Area Layout
Click on the [Display Tag] in the [Option] dialog box.

[Tree View Area Layout]
Select the display position of the Tree View Area Layout.

Displays an oblong (in the vertical direction)
Tree View Area Layout at the left-hand side.

Displays an oblong (in the horizontal
direction) Tree View Area Layout at the
bottom.

12. Option Setup
The [Option] dialog box is used for various setups of the VN-S400.
To display the [Option] dialog box, open the [Setting] menu and select [Option].
After completing setups, click on the [OK] button to close the [Option] dialog box.

[Display] tab

[Option Setting] dialog box
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[Alarm 3/Motion Detect]
Specify the color of the frame around the View Window receiving
the Alarm 3/Motion Detect alarm.

[Alarm 4/Relay Alarm]
Specify the color of the frame around the View Window receiving
the Alarm 4/Relay alarm.
(To display a color frame around a View Window receiving an alarm,
it is required to select [Highlight] in section 11-2, "Setting the Opera-
tion Upon Alarm Reception" and specify enhancement of the View
Window.)

[Motion Grid Color]
Specify the display color of the motion detection grid set to the View
Point.

[Motion Area Color]
Specify the display color of the detection setting area set to the View
Point.

[Motion Detect Color]
Specify the display color of the motion detection area set to the View
Point.
(For the display of the motion grid color, motion area color and mo-
tion detect color, see section 13-2, "Motion Detection Display." For
the method of setting motion detection in a View Point, refer to the
instruction manual of the relevant connected device of the View Point.)

12-4. Setting the Primary Window
Click on the [Display Control] tab in the [Option] dialog box.

[Recording]
If selected, the VN-S400U reduces the frame rates of the View Win-
dows which is not recorded so that the frame rate of the image in the
recording View Window can be maintained at the set rate as much
as possible.

[Active View Window]
The VN-S400U reduces the frame rates of the non-active View Win-
dows so that the frame rate of the image in the active View Window
can be maintained at the set rate as much as possible.

See the section 16, “Primary Window” for the details.

[Display] tab

[Option Setting] dialog box

[Display Control] tab

[Option Setting] dialog box
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12-5. Setting the Recording File Save Period
Click on the [Recording] tab in the [Option] dialog box.

[Save Period]
Select the period for which the recording files are to be retained.
Non Limit: Recording files are retained without deletion by the save

period.
Days: Files are retained for the period specified in this box and

overdue files are deleted automatically.
(For example, “3 days” means that the file which recorded
today is retained for 3 days including today, after that
deleted automatically.)

[Disk Full]
Select the processing to be executed in case the disk runs out of
available capacity during recording.
Rec Cancel:Recording is stopped.
Delete: Files recorded during the ‘deletion period’ which is speci-

fied in this box are deleted automatically. (note 1)
(For example, “... 3 days before” means that including
the day 3 days ago and before are ‘deletion period’.)

<< CAUTION >>
(note 1) In case that [Delete files created --- days before] is selected, the recording will be stopped if there are no files
to be deleted by the deletion period in the save location or the disk space is not enough in spite of deleting files.
Additionally, the recording may be stopped depending on the relationship between file size of recording and deleting.

The following image files are targets of automatic deletion.
REC file (*.rec),   ASF file (*.asf),   JPEG file (*.jpg),   BMP file (*.bmp),   AVI file (*.avi)

The recording will be stopped in case the disk runs out of available capacity (100 to 200 MB space) at any condition.
To continue the recording, keep to make the disk 70% or less occupied by deleting old recording files using effectively
the file save period setting.

[Recording] tab

[Option Setting] dialog box

*

*

*



30

12-6. Setting the Password
Click on the [Password] tab in the [Option] dialog box. This area is for setting the V.Networks default password and
Work Space password.

[ V.Networks default password ]
If no check mark is put in the [Particular Password Enable] box at the
View Point Setting dialog box, this Default Password is required when
VN-S400U connects with the View Point when the View Point is
V.Networks (VN-C1U/C2U/C3U/C30U/A1U/C10U).
See the section 15-3, “Setting the Password for a View Point
(V.Networks)” about the View Point Setting dialog box and particular
password for the View Points.

Enter a password within 8 characters.
Enter it again in the [Re Type] box.

Click [Update] button to make this password enabled.

[ Work Space password ]
This password is required when VN-S400U opens this Work Space
and switches the protect mode.

Enter a password within 8 characters.
Enter it again in the [Re Type] box.

Click [Update] button to make this password enabled.

Check [Require this password when the Work Space is opened]
to make the user enter this password to open this Work Space.
Check [Protect mode ON] to make the protect mode effective
when this Work Space is opened.

1
2

[Password] tab

[Option Setting] dialog box

1
2
3
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12-7. Protect Mode
Open [Protect Mode] tab at the [Option] dialog box.
Protect mode is for restricting the operation of VN-S400U. Some operations which is permitted in advance can be
used during the protect mode. Choose the operations to be permitted during the protect mode in this tab.

R
eg

is
te

r/D
el

et
e

V
ie

w
 C

ha
nn

el
s

Open/Close Work Space

Close VN-S400U

Display/Hide Toolbar

Display versions

Operate live controller

Switch sequential displaying

Operate VN-C2U/C3U/C30U controllers

Operate external device controllers

Operate playback controller

View Window alignment

Register/Delete View Channels

Allowed operations

(Checked subject enables you to
operate “O” marked functions
listed below during protect mode.)
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Click [Protect Mode] from [Setting] menu to make the protect mode effective. The mode is effective if a check mark is
put beside it. Click [Protect Mode] from [Setting] menu again to release it.
A password will be required when you switch the protect mode to be enabled or disabled. This password is the same
as the Work Space password. See ‘12-6. Setting the Password’ for more details of the password.

<< CAUTION >>
The Work Space can not be saved during protect mode, and VN-S400U is closed without saving message despite the
modifications if it is closed. (The modifications in the Work Space are abandoned.)

[Protect Mode] tab

[Option Setting] dialog box
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12-8. Setting the E-Mail Sending Address Upon Alarm Reception
Click on the [Mail] tab in the [Option] dialog box.
When E-mail notice is selected as an operation upon alarm reception, the E-mail is sent to the address specified
under this tab. (For the alarm, see chapter 11, "Alarm Setup.")

SMTP Server name: Specify the SMTP server name.
Port Number: Specify the port number.
From Address: Specify the mail sender address.
To Address: Specify the mail destination address.

At least one address is required.
(It is possible to enter up to ten ad-
dresses by separating each address with
a comma or a space.)

CC: Specify the mail address for CC.
(It is possible to enter up to ten addresses by separat-
ing each address with a comma or a space.)

BCC: Specify the mail address for BCC.
(It is possible to enter up to ten addresses by separat-
ing each address with a comma or a space.)

Subject: Specify the subject of the mail.

[Mail] tab

[Option Setting] dialog box
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13. Live View Window Setup
This chapter describes how to set up the Live View Windows.

13-1. Changing the View Window Name and Its Display Size
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Display] tab.

View Window Name
The current View Window name is displayed. If it is required to
change the name, enter the desired View Window name within 32
characters.

Window Size
Select the size of the View Window.

13-2. Motion Detection Display
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Display] tab.

Selecting [Enable] causes the motion grid color, motion area color
and motion detect color to be displayed in the View Window. Their
display colors can also be specified (for the procedures, see section
12-3, "Highlighting the View Window").
It is necessary to set the equipment of the View Point to use the
motion detection.

* This function is valid only when the View Point is VN-A1U or a
  JPEG View Channel of VN-C10U.

[Live View Window Setting] dialog box

[Display] tab

[Live View Window Setting] dialog box

[Format] tab
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13-3. Setting the Sequential Interval
Sequential interval refers to viewing multiple View Channels registered
for a single Live View Window by switching them in a proper order at a
constant interval. (This function is guaranteed for only when the View
Channel is a JPEG View Channel.)
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Display] tab.
In [Sequential Interval], enter the number of seconds (5 to 120 sec-
onds can be entered.)
To enable sequential display, click on the [Sequential Start] button in
the live view controller. Each click enables and disables the sequential
display alternately.

When the sequential display is disabled, the button becomes the [Start
Sequential] button and the View Channel list below the button is en-
abled. The registered View Channel can now be changed by clicking in
this list.

13-4. Setting the REC Indication
This function displays characters "REC" in the View Window during
recording.

Click on the desired Live View Window to turn it active, open its [Set-
ting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Display] tab.

If [Indicate REC Status] is clicked, the characters "REC" are displayed
during recording.

[Live View Window Setting] dialog box

[Display] tab

Live Controller

[Live View Window Setting] dialog box

[Display] tab
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13-6. Setting the Time Stamp Display
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View
Window icon on the Tree View Area Layout.)
Click on the [Format] tab.

[Time Stamp]  Select one of the following options.

Disable (The time stamp is not displayed.)
YYYY/MM/DD HH:MM:SS.mm   (Year/Month/Day/Hour:Minute:
                                                                    Second.Millisecond)
YYYY/MM/DD HH:MM:SS  (Year/Month/Day Hour:Minute:Second)
DD/MM/YYYY HH:MM:SS  (Day/Month/Year Hour:Minute:Second)
MM/DD/YYYY HH:MM:SS  (Month/Day/Year Hour:Minute:Second)
MM/DD HH:MM:SS            (Month/Day Hour:Minute:Second)
HH:MM:SS (Hour:Minute:Second)
HH:MM (Hour:Minute)

[Time stamp display colors]
Click on the [Color Setting] buttons for [Time Stamp Color] and [Time
Stamp Back Color] and set the respective colors. If [Transparent] is
checked, the background becomes transparent.

13-5. Setting the Connected View Point Information Display

[Live View Window Setting] dialog box

[Format] tab
This function displays the information on the View Point being
connected in the View Window.
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View
Window icon on the Tree View Area Layout.)
Click on the [Format] tab.

Select one of the following options from the [Info Display Format] list.

Disable: The View Point information is not displayed.
Name: The View Channel name is displayed. Its IP ad-

dress is shown additionally if the [Display IP Ad-
dress] setting of the tree view area layout is ON.

Name/Model: The View Channel name and the device model
name are displayed. Its IP address is shown addi-
tionally if the [Display IP Address] setting of the
tree view area layout is ON.

* For setting [Display IP Address] of the tree view area layout, see section
12-2, “Showing / Hiding the IP addresses” or  section 19-2, “Menus Dis-
played by Right-clicking on Icons in the Tree View Area Layout”.

[Live View Window Setting] dialog box

[Format] tab



36

13-8. Setting the Recording File Save Location

13-7. Setting the Alarm Message Display Colors
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Format] tab.

[Alarm Message Color] and [Alarm Message Back Color] can be speci-
fied by clicking the respective [Color Setting] buttons.
If [Transparent] is checked, the background becomes transparent.
(For the contents of the alarm messages, see section 11-2, "Setting
the Operation Upon Alarm Reception.")

This function sets the location for saving the files obtained by record-
ing the image in the Live View Window.
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Rec] tab.

[Rec Path] shows the currently set save location. If it is required to
change it, enter the new save location beginning with its drive letter.
(e.g.) C:\Document and Setting\Administrator\Workspace1\ViewWindow1
Set the local drive as the saving place of files. It may malfunction by
setting the network drives as the saving place.

* Refrain from modifying the save location during recording. Stop recording once
before modifying the save location. This modification will be effective on the next
recording.

13-9. Starting REC automatically by Opening the Work Space
Initial Start starts recording images of  the Live View Window automati-
cally when the Work Space is opened.
(This function is valid only when the View Channel is a JPEG View
Channel.)

Click on the desired Live View Window to turn it active, open its [Set-
ting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Rec] tab.

If [Rec Start] of [Auto REC] area is checked, it starts recording auto-
matically when the Work Space is opened.

[Live View Window Setting] dialog box

[Format] tab

[Live View Window Setting] dialog box

[Rec] tab

[Live View Window Setting] dialog box

[Rec] tab
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13-10. Timelapse Recording
Timelapse recording records images of the Live View Window frame
by frame at a constant interval.
(This function is valid only when the View Channel is a JPEG View
Channel.)
Click on the desired Live View Window to turn it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Rec] tab.
Recording interval can be specified between 1 and 120 seconds.

13-11. Alarm Recording
This function sets the conditions for recording the alarms received in
the alarm list.
Click on the desired Live View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by double clicking on the Live View Win-
dow icon on the Tree View Area Layout.)

Click on the [Rec] tab.
Set [Alarm Rec]

Only Rec Status: An alarm is recorded in the alarm list only when
the Live View Window receives an alarm during
image recording.

Always: All received alarms are recorded in the alarm list.
Disable: Received alarms are not recorded in the alarm list.

[Live View Window Setting] dialog box

[Rec] tab

[Live View Window Setting] dialog box

[Rec] tab
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14. Play View Window Setup
This chapter describes how to set up the Play View Windows

14-1. Changing the View Window Display Size
Click on the desired Play View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by clicking on the Play View Window icon
on the Tree View Area Layout.)

Click on the [Display] tab.
Select the View Window display size.

14-2. Motion Detection Display
Click on the desired Play View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by clicking on the Play View Window icon
on the Tree View Area Layout.)

Click on the [Display] tab.

Selecting [Enable] causes the motion grid color, motion area color
and motion detect color to be displayed in the View Window. Their
display colors can also be specified (for the procedures, see section
12-3, "Highlighting the View Window").

14-3. Playback Mode Indication
Click on the desired Play View Window to turn it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by clicking on the Play View Window icon
on the Tree View Area Layout.)

Click on the [Display] tab.

Checking [Indicate Playback Status] causes the mode of the active
Play View Window (PLAY, PAUSE, etc.) to be indicated in the window.

[Play View Setting] dialog box

[Display] tab

[Play View Setting] dialog box

[Display] tab

[Play View Setting] dialog box

[Display] tab
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14-4. Setting the Recording View Point Information Display
This function displays the information on the recorded View Point in
the View Window.
Click on the desired Play View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by clicking on the Play View Window icon
on the Tree View Area Layout.)

Click on the [Format] tab.
Select one of the following options from the [Info Display Format] list.
Disable: The View Point information is not displayed.
Name: (In case of PC recorded file)

The View Channel name is displayed. Its IP address is
shown additionally if the file has been recorded with the
setting of [Display IP Address] of the tree view area
layout was ON.
(In case of Local recorded file)
The name provided from the connected device is displayed.

* It is not possible to display the name of the View Point if the recorded file is
  ASF.  An ASF file (*.asf) is created when the View Channel is an MPEG-4
  channel.

14-5. Setting the Time Stamp Display
Click on the desired Play View Window to make it active, open its
[Setting] menu and select [View Window].
(It is also possible to setup by clicking on the Play View Window
icon on the Tree View Area Layout.)

Click on the [Format] tab.

[Time Stamp Format]
Select one of the following options.

Disable (The time stamp is not displayed.)
YYYY/MM/DD HH:MM:SS.mm   (Year/Month/Day/Hour:Minute:
                                                                    Second.Millisecond)
YYYY/MM/DD HH:MM:SS  (Year/Month/Day Hour:Minute:Second)
DD/MM/YYYY HH:MM:SS  (Day/Month/Year Hour:Minute:Second)
MM/DD/YYYY HH:MM:SS  (Month/Day/Year Hour:Minute:Second)
MM/DD HH:MM:SS            (Month/Day Hour:Minute:Second)
HH:MM:SS (Hour:Minute:Second)
HH:MM (Hour:Minute)

[Time Stamp display colors]
Click on the [Color Setting] buttons for [Time Stamp Color] and
[Time Stamp Back Color] and set the respective colors. If [Transpar-
ent] is checked, the background becomes transparent.

[Play View Setting] dialog box

[Format] tab

[Play View Setting] dialog box

[Format] tab
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15-1. Changing the View Point Name
This function changes the View Point name and View Channel name.

In the Tree View Area Layout, select the View Point or View
Channel to be renamed.

Open the [Setting] menu and select [View Point].The [View
Point Setting] dialog box appears, and click [General] tab.

Enter a new name for [View Point Name] or [View Channel
Name]. Two names, for an MPEG channel and a JPEG chan-
nel are required when the View Channel is DM-NC40U.
(Each name should be within 32 characters.)

* If the View Channel name is modified during recording, the
part  after the modification will be recognized as another View
Channel when it is played back.

Click on the [OK] button to close the dialog box.

15. View Point Setup

15-2. Setting the Password for a View Point (DM-NC40U)
When the View Point is a DM-NC40U, this function sets the account for the DM-NC40U.(The user name and the password.)
The account settings at the VN-S400U is saved in the Work Space. If the account in the Work Space matches the account
of the DM-NC40U, it is possible to connect with the DM-NC40U when the Work Space is opened.

In case that the DM-NC40U is running without any changing of its account, the VN-S400U can connect with the DM-
NC40U without the account settings at the VN-S400U when a DM-NC40U is registered as a new View Point because
the both accounts are the default value.

To change the account of the DM-NC40U, it is necessary to set it through the Internet browser. See the DM-NC40U’s
Instructions about the account settings of the DM-NC40U. (It is impossible to change the account of the DM-NC40U
at the VN-S400U.)

Set the account by the following procedure if the account of the Work Space does not match that of the DM-NC40U.

In the Tree View Area Layout, select the desired View Point or
the View Channel.

Open the [Setting] menu and select [View Point].
The View Point Setting dialog box appears, and click [Pass-
word] tab at this dialog box.

Click [Change] to be changed field.

* The [Use name] will be red if the account does not match.

(continued on the next page)

1
2
3

4

1
2

3

[View Point Setting] dialog box

[General] tab

[View Point Setting] dialog box

[Account] tab
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The Change Account dialog box appears.
Enter a new account and type it again in the [Re Type], click [OK].

Click [OK] at the View Point Setting dialog box to close the dialog box.

15-3. Setting the Password for a View Point (V.Networks)
When the View Point is a model of V.Networks; VN-C1U/C2U/C3U/C10U/C30U or A1U, this function sets the password
for connecting to the View Point. The password settings at the VN-S400U is saved in the Work Space. If the password in
the Work Space matches the password of the V.Networks, it is possible to connect with the V.Networks when the Work
Space is opened.
No password is set at the Work Space when the V.Networks is registered as a new View Point, however it is possible to
connect with the V.Networks if the V.Networks does not have its password. (It is possible to connect with the V.Networks
without the password setting at the Work Space if the default password of this Work Space matches the password of the
V.Networks even if the V.Networks has its password.)
To set or change the password of the V.Networks, use the tools such as “Setup Tool” to change it on the V.Networks. See
the V.Networks’ instructions about the password settings. (It is impossible to change the password of V.Networks at
VN-S400U. Close the Work Space once and open it again after changing the settings of V.Networks by a tool such as
“Setup Tool” during VN-S400U’s running.)

VN-S400U can not connect with the V.Networks and an error message appears if the password for the V.Networks or the
default password of the Work Space does not match that of V.Networks. In case of the unmatch of these passwords, set
the password by the following procedure.

In the Tree View Area Layout, select the desired View Point or
the View Channel.

Open the [Setting] menu and select [View Point].
The View Point Setting dialog box appears, and click [General]
tab at this dialog box.

Check the [Particular Password Enable] box and enter the de-
sired password within 8 characters in [Pass-word] blank.
Enter the same password again in [Re Type], and click [Apply].

The password entry will be requested to connect with the View
Point if [Particular Password Enable] is checked.
If not checked, the Default Password will be used which is
specified at the Option dialog box. See section 12-6, "Setting
the Password for the Work Space (Default Password)" about
setting the Default Password.

Click on the [OK] button to close the View Point Setting dialog
box.

5
4

5

1
2

3

4 [View Point Setting] dialog box

[General] tab
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15-4. Setting the Connection Port
This function sets the port number for connection with View Points.

In the Tree View Area Layout, select the desired View Point or
the View Channel.

Click [Setting] menu and select [View Point].
The [View Point Setting] dialog box ap-pears, and click [Port]
tab. The changes of settings at this dialog box will be effective
after opening this Work Space next time.

* Well-Known ports (1 to 1023) are recommended for this
  port setting.

In case that the View Point is DM-NC40U

[RTP Image] Set the port for receiving the uni-cast image of the MPEG-4 channel.
The default configuration is zero (0).
0: VN-S400U selects a port automatically.
An even number from 2 to 65534: Enter a desired port number.

[RTP Sound] Set the port for receiving the uni-cast sound of the MPEG-4 channel.
The default configuration is zero (0).
0: VN-S400U selects a port automatically.
An even number from 2 to 65534: Enter a desired port number.

[Alarm Receiving] Sets the port for receiving the alarm from DM-NC40U.
The default configuration is 10000.
1 -- 65535: Enter a desired port number.

* This port is shared with all of the connected DM-NC40U in the Work Space.
* It is necessary to set the destination of the alarm at the DM-NC40U side.

In case that the View Point is V.Networks

[RTP] Set the port for receiving MPEG-4 channel of VN-C10U.
The default configuration is zero (0).
0: VN-S400U selects a port automatically.
1 -- 65535: Enter a desired port number.

[Alarm Receiving] Sets the port for receiving the alarm from V.Networks which supports the alarm function.
The default configuration is 5001.
0: VN-S400U selects a port automatically.
1 -- 65535: Enter a desired port number.

* This port is shared with all of the connected V.Networks in the Work Space.
* It is necessary to set the alarm setting at the V.Networks to receive alarm signals at VN-S400U.

1

2

[View Point Setting] dialog box (In case of DM-NC40U)

[Port] tab
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15-5. Setting the Image
This section is for setting the image received from View Points. The subjects for settings depend on the connected
View Point.

In the Tree View Area Layout, select the desired View Point or View Channel.

Click [Setting] menu and select [View Point]. The [View Point Setting] dialog box appears. Open [Image] tab of at
the dialog box.
The updates of [Receive by the frame rate of the camera] and [JPEG frame rate [fps] ] are executed by clicking [OK]
at this dialog box. The updates of [MPEG-4 Multicast Receiving] and [MPEG-4 TCP mode] are executed by hiding
the Live View Window once and display it again after clicking [OK] at this dialog box.

[ In case that the View Point is DM-NC40U ]
MPEG-4 Multicast Receiving

Check it to enable multicast receiving of the MPEG-4 channel from
DM-NC40U.(Control it during the indication of “Multicast” section
at “Network Setup” of the DM-NC40U is displayed [START].)

MPEG-4 TCP mode
Check it to set the transport layers of the sound and the image to
TCP. The default configuration (OFF) is set to UDP. This setting
may help to playback the sound and the image smoothly when the
network environment is not sufficiently reliable. See the instruc-
tions manual of DM-NC40U for more details about this setting.
* It is not permitted to set both [MPEG-4 Multicast Receiving] and [MPEG-4
TCP mode] at a same time.

JPEG Frame Rate [fps]
Set the frame rate of the transferred image of JPEG channel from
DM-NC40U. Selecting a higher frame rate makes the motion in
the image smoother.
(This option is not the setting for the DM-NC40U, but for the VN-
S400U when it receives the image. )

[ In case that the View Point is V.Networks ]
Receive by the frame rate of the camera

Check it to receive the image from the View Point by its sending
frame rate  which is set on the View Point equipment. See ‘15-7.
Setting the View Point Image (V.Networks)’ for the procedure of
setting the sending frame rate.
Remove the check mark at this and check [JPEG frame rate [fps] ]
to receive the image by the frame rate of the VN-S400U.

JPEG frame rate [fps]
Set the frame rate of the transferred image of JPEG channel from
DM-NC40U. Selecting a larger frame rate makes the motion in the
image smoother.
(This option is not the setting for the DM-NC40U, but for the VN-
S400U when it receives the image. )
* In multicasting, the actual frame rate for displaying or recording at VN-
S400U is lower than the rate of V.Networks even though a higher frame
rate is specified at VN-S400U than V.Networks.

* The actual frame rate for displaying or recording is depending on the casting ability of
the View Point, the LAN environment and the PC spec.

1
2

[View Point Setting] dialog box  (In case of DM-NC40U)

[Image] tab

[View Point Setting] dialog box  (In case of V.Networks)

[Image] tab
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15-6. Setting the View Point Image (DM-NC40U)
When the View Point is a DM-NC40U, this function changes the image settings, etc. of the View Point.

In the Tree View Area Layout, select the desired View Point or View Channel.

Double click on the View Point icon or the View Channel icon, or open the [Setting] menu and select [View Point
Control]. The [View Point Control] dialog box appears.
The current values of the View Point equipment(*1) are displayed on the ‘View Point Control’ dialog box. If you
modify the values at this dialog box, the new values are reflected to the View Point equipment immediately.

(*1) The values of [Memo] at [OUTPUT PIN] tab are not the values of the View Point equipment, but saved on the Work Space.

[Network tab]
Click on the [Network] tab.
This tab shows the information on the View Point.

[Image tab]
Click on the [Image] tab.

Settings for the MPEG-4 channel;
INPUT1 / INPUT2

Choose the input interface for the MPEG-4 channel of the DM-NC40U.
P in P

Switch the setting of P in P (Picture in Picture) of DM-NC40U.  See the
instructions manual of DM-NC40U for more details. (The current status is
not displayed in some versions of DM-NC40U.)

Image Size
Shows the image size of the MPEG-4 channel.
Selecting a larger size makes the image clearer and less uneven.
(Note that this is not the size of the displayed View Window but the size of
the transferred image.)
To change it, use the Internet browser. See the instructions of  DM-NC40U
for the details.
* [176x120] and [160x120] are not supported. Use at [352x240] or [320x240]
setting.

Image Bit Rate
Shows the image bit rate of the MPEG-4 channel.
To change it, use the Internet browser. See the instructions of  DM-NC40U
for the details.

Frame Rate
Shows the image frame rate of the MPEG-4 channel.
To change it, use the Internet browser. See the instructions of  DM-NC40U
for the details.

Sound Bit Rate
Shows the sound bit rate of the MPEG-4 channel.
To change it, use the Internet browser. See the instructions of  DM-NC40U
for the details.

Settings for the JPEG channel;
INPUT1 / INPUT2

Choose the input interface for the JPEG channel of the DM-NC40U. (It can
not be controlled if the JPEG channel is enabled at the DM-NC40U.)
This setting resets the performance of DM-NC40U, and it may interrupt
the connection with other View Windows and clients momentarily. After
this setting, refrain from clicking [Cancel] at this dialog box or chang-

[Network] tab

1
2

[View Point Control] dialog box

[View Point Control] dialog box

[Image] tab
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15-7. Setting the View Point Image (V.Networks)
When the View Point is a model of V.Networks; VN-C1U/C2U/C3U/C10U/C30U/A1U, this function changes the im-
age settings, etc. of the View Point. The type of the dialog boxes and setting subjects vary according to the model of
the View Point.

In the Tree View Area Layout, select the desired View Point or View Channel.

Double click on the View Point icon or the View Channel icon, or open the [Setting] menu and select [View Point
Control]. The [View Point Control] dialog box appears.
The current values of the View Point equipment(*1) are displayed on the ‘View Point Control’ dialog box. If you
modify the values at this dialog box, the new values are reflected to the View Point equipment immediately.

(*1) The values of [Memo] at [Alarm Out] tab are not the values of the View Point equipment, but saved on the Work Space.

[Network tab]
Click on the [Network] tab.
This tab shows the information on the View Point.

[Image tab]
Click on the [Image] tab.
Mode

Shows either the "JPEG" or "MPEG-4" mode.
Casting mode

Shows either the “Unicast” or “Multicast” mode.
Upside Down

If checked, the image is displayed upside down.
Size

Set the size of the image transferred from the View Point.
Selecting a larger size makes the image clearer and less uneven.
(Note that this option sets the size of the transferred image and does not set
the size of the displayed View Window.)

Fine Mode
If checked, the Fine Mode is effective.
- It is effective only with the VN-C10U Ver.1.4 or higher.
- It is effective only by 640 x 480 image size.
Fine Mode makes the still image clear and detailed, but the Fine Mode  does
not suite for the subject if it is moving.

[Image] tab

[Network] tab

[OUTPUT PIN] tab

1
2

ing other settings until the performance of DM-NC40U is recovered.
[OUTPUT PIN tab]
Click on the [OUTPUT PIN] tab.
Set the output signal polarities for each alarm output interfaces of the DM-NC40U.
[High] Outputs the High signal.
[Low] Outputs the Low signal.

See the instructions of DM-NC40U for details of the alarm interfaces.

[View Point Control] Dialog box

[View Point Control] Dialog box
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[Lens Settings tab]
Click on the [Lens Setting] tab.
(This tab is displayed only with the VN-C3U and VN-C30U.)
Zoom Adjust the zoom ratio.
Focus Adjust the focusing.
Iris Adjust the camera iris.

[Alarm Out tab]
Click on the [Alarm Out] tab.

The alarm signal is output according to the alarm output settings per-
formed on the camera. This setting requires careful consideration be-
cause it causes the alarm output terminal to output an actual alarm signal.

[Lens Setting] tab

Alarm Out tab

[Image Setting] tab (2)

Frame Rate
Set the maximum frame rate of image transfer from the View Point.Selecting
a larger frame rate makes the motion in the image smoother.
* The actual frame rate for displaying or recording is depending on the casting ability of
the View Point, the LAN environment and the PC spec.

[Image Setting tab]
Click on the [Image Setting] tab.
Saturation Adjust the color saturation.
Color Balance Adjust the white balance.
Exposure Adjust the image exposure.
Brightness Adjust the image brightness.
Agc Adjust the gain of the built-in amplifier.
High Gain mode Switch the High Gain mode.

* It is effective only with the VN-C10U Ver.2.0 or higher.
Compression Level Set the image compression level. Setting a larger

value increases the compression rate.
White Balance Adjust the white balance.
Blc Compensate the back light.
Aes Adjust the shutter speed depends on the brightness

of the subject.
Shutter Speed Select the shutter speed.
Iris Adjust the iris.

The conditions return to the default level by clicking [Default].

[Image Setting] tab (1)
[View Point Control] Dialog box
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15-8. Setting an External Device
When the View Point is a VN-A1U or a DM-NC40U unit, this function makes settings concerning the external device
connected with the View Point.

In the Tree View Area Layout, select the desired View Point or View
Channel to be set of the external device.

Open the [Setting] menu and select [View Point].
The [View Point Setting] dialog box appears.
Click on the [External] tab.

Check the connection terminal to be set. (COM1 or COM2).

Select the connected device model from [Equipment Type].

Enter the connected device name within 32 characters.
This name is displayed in the View Channel selection area of the Live
Controller or Playback Controller.

When the View Point is DM-NC40U, it is required to select the way of ob-
taining / releasing the right to control the external device. The external de-
vice can be controlled by one VN-S400U which obtained the right to control
for the reason of avoiding access conflict to the serial port of DM-NC40U.
Select the way of treating of right to control in here.

[ While the External device controller is displayed. ]
VN-S400U obtains the right to control only when it displays the external
device controller, and the right is released by hiding the external device
controller. In this setting, VN-S400U can control the external device reliably
without losing the right to control in its operations because it keeps the right
throughout the displaying of the external device controller.

[ Only while operation is executed.]
VN-S400U obtains the right to control only when it clicks or does other
operations on the external device controller. The right is released automati-
cally after about five seconds of the last operation.

A message “Occupied by other client.” or  “Communication error” will be
shown on the VN-S400U screen when it failed to control the external device
because it has been controlled already by another VN-S400U. In this case,
try to control it again after a while. Your VN-S400U can obtain the right to
control if the external device is free from the control by another VN-S400U.

* After changing the way of obtaining/releasing the right to control the external device, hide
the external device controller once and display it again to enable the new setting.

5

1
2

3
4

6

[External] tab

[View Point Setting] dialog box
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16. Primary Window
The stable operation of the VN-S400U becomes difficult when the load to the CPU exceeds 100% due to an increase in
the number of connections, etc. Therefore, the VN-S400U monitors the CPU load and, if it is going to exceed 100%,
limits the displaying performance of each Live View Window to avoid overloading, for example, reduce the frame rates of
Live View Windows.for example.
“Primary Window” is the function to control and limit the display performance of each View Window based on the
specified priorities.

The Primary Window can be turned to effective by clicking [Primary Window]
from the [Setting] menu. When the Primary Window is effective, a check mark is
displayed on the menu display.
Primary Window can be canceled by clicking the [Primary Window] from the
[Window] menu again. The check mark is cleared.

[When Primary Window is effective]
The VN-S400U reduces the frame rates of the low-priority View Windows so
that the high-priority View Window keeps its frame rate at the specified value.
Choose the high-priority View Window from “Recording” or “Active View Win-
dow” at the [Display Control] tab of the [Option Setting] dialog box. (See the
section 12-3, “Setting the Primary Window”.)
In the View Window of JPEG channel, the receiving frame rate is reduced at
the VN-S400U to control the CPU load, and then in the MPEG-4 View Win-
dow, the number of frames of the image to be decoded is reduced to control
the CPU load.

[When Primary Window is not effective]
The VN-S400U reduces the frame rates of all of the View Windows of JPEG
channels in case the CPU load is going to exceed 100%. In the View Window
of MPEG-4 channel, the frame rate is not reduced.

* Some Live View Windows are reduced their frame rates because of the
  overloading by general performance of this program even if the Primary Win-
  dow is effective.

[Setting] menu



17-2. Displaying View Windows in a Registered Pattern

17. Load Pattern of the View Windows
This chapter describes how to make load patterns of the registered View Windows.

17-1. Registering the View Window Load Patterns
This function registers the display sizes and positions of the View Windows.
Up to 20 load patterns can be registered.

Adjust the positions and display sizes of the View Windows.

Open the [Window] menu, select [Save Pattern] and click on the desired
one of the pattern numbers from [No. 1] through [No. 20].

To modify a previously registered load pattern, set the View Window posi-
tions and sizes as desired, perform step 2 above and click on the pattern
number of the pattern to be modified.

17-3. Display / Hide View Windows
Display / Hide all of registered View Windows:
To display all View Windows, choose [Display All] from the [Window] menu.
To hide all View Windows, choose [Hide All] from the [Window] menu.

Display / Hide desired View Windows:
(Any of the way from 1 to 3 is effective for switching display or hide the windows.)

1. Right-click on the desired View Window and choose [Display] or [Hide] from
   the pop-up menu.

2. Right-Click on the View Window icon of the desired View Window and choose
   [Display] or [Hide] from the pop-up menu.

3. Click on the View Window name from [Window] menu. The name of dis-
   playing View Window has the check mark, and the name of hidden View
   Window does not. When the hidden View Window is clicked to be displayed,
   it turns to active immediately.

This function displays the View Windows in one of the registered load patterns.

Open the [Window] menu, select [Load Pattern] and click on the desired one of
the pattern numbers from [No. 1] through [No. 20].
The View Windows will be displayed in the selected pattern.

1
2
3

[Window] menu

[Window] menu

[Window] menu

Select a pattern number
to register.

Select a pattern number.

D i s p l a y  o r
hide all View
Windows

C l i c k  V i e w
Window name
to be displayed
or hidden.
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The Tree View Area Layout shows the registration status of the View Windows, View Points and View Channels.
Click on the [WP], [W] or [P] tab according to the function to be executed in this window.
When the list display layout is changed in the [Option] dialog box, the Tree View Area Layout is modified while the
displayed information stays identical. The following descriptions take the Tree View Area Layout that is displayed as
an oblong in the horizontal direction as an example.

18-1. Displaying an Image in Live View Window
Click on the [WP] tab.

18. Tree View Area Layout Operations

(1)

(2) (4)
(5)

At the left-half section under the [WP] tab,
it shows the following information.
(1)Four Play View Windows
(2)Registered Live View Windows
(3)View channels assigned to the Live View Windows
(4)PC REC File icons (Information on the image recording files)
(5)Alarm List icons (Information on alarm receptions)

At the right-half section under the [WP] tab,
it shows the following information.
(1)Registered View Points
(2)View Channels
   (  icons are JPEG channels /   icons are MPEG-4 channels)
(3)Information on each View Point
   [External device connected to the View Point]
   [LOCAL REC Files (Information on the files recorded in the
    connected device at the View Point)]

Click on the View Channel to be viewed, in the right-half sec-
tion.

Drag & drop the selected View Channel on the Live View Win-
dow icon in the left-half section.

The channel will be added below the Live View Window icon in
the left-half section.

Up to 16 channels can be registered per a Live View Window by
repeating the same procedure as above. In the case of an MPEG-
4 channel, one channel can be registered per Live View Window.

* It is not permitted to register a single View Channel more than once in a Live View Window.
* It is not permitted to register both of MPEG-4 View Channel and JPEG View Channel in a Live View Window.
* It is not permitted to register plural number of MPEG-4 View Channels in a Live View Window.
* One MPEG-4 View Channel can be registered in a Live View Window.

(3)

(3)

(2)
(1)

Tree View Area Layout  [WP] tab

Tree View Area Layout  [WP] tab

Drag the View Channel icon to the
Live View Window icon.

1
2
3
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18-2. Creating a View Point Group
Click on the [WP] tab or [P] tab.
This function creates a View Point group folder for arranging the registered View Points.

Open the [Insert] menu and select [View Point Group].

A new View Point group folder is created in the right-half section of
the Tree View Area Layout.
Enter the View Point group name in 32 characters.
(To modify the name, right-click on the View Point group folder to
open a menu and select [Rename] from it.)

Drag & drop the desired View Point icons in the View Point group
icon. The dropped View Points will be included in the View Point
group.

18-3. Playing Back a PC Recording File
The PC recording files to be played back can be selected in the Tree View Area Layout.
For the operating procedure, see section 8-1, "Playing Back a PC Recorded File."

18-4. Playing Back a Local Recorded File
The local recording files to be played back can be selected in the Tree View Area Layout.
For the operating procedure, see section 8-2, "Playing Back a Local Recorded File."

1
2

3

Tree View Area Layout  [WP] tab or [P] tab

A new View Point group

Drag the View Point icon.
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18-6. Deleting Registered Items
This function deletes a registered Live View Window, View Point or the items listed below.

[Deleting a Live View Window]
Select a Live View Windows icon on the Tree View Area Layout and press [Delete] key, or right-click on the icon and
select [Delete] from the displayed menu. When the deletion confirmation message appears, click on the [OK] button.

[Deleting a View Point]
Select a View Point icon on the Tree View Area Layout and press [Delete] key, or right-click on the icon and select
[Delete] from the displayed menu. When the deletion confirmation message appears, click on the [OK] button.
Note that the View Points registered in the Live View Windows cannot be deleted.

[Deleting a View Point Group]
Select a View Point Group icon on the Tree View Area Layout and press [Delete] key, or right-click on the icon and
select [Delete] from the displayed menu. When the deletion confirmation message appears, click on the [OK] button.
Note that deleting a View Point group results in deleting all of the View Points included in it. However, the View Points
registered in Live View Windows are not deleted.

[Deleting a register of a View Channel]
Select a View Channel icon on the left-half section of the Tree View Area Layout and press [Delete] key, or right-click
on the icon and select [Delete] from the displayed menu. When the deletion confirmation message appears, click on
the [OK] button.

[Deleting a register of a REC file]
Select a REC file icon on the Tree View Area Layout and press [Delete] key, or right-click on the icon and select
[Close File] from the displayed menu. When the confirmation message appears, click on the [OK] button.

Occurrence time
View Point

Alarm type
Recording file

18-5. Displaying the Alarm List
Click on the [W] tab, or double-click [Alarm List] icon to make the [W] tab come to the front.
The left-half section shows the status of the registered View Windows. The right-half section shows the records of alarm
receptions.

In the left-half section, click on the [Alarm List]
icon under the desired live View Window name.

The detailed alarm list is shown in the right-
half section. The displayed information in-
cludes the alarm occurrence time, View Point
names and alarm types. With alarms that
have been recorded in files, the entire alarm
information is displayed in red together with
the recording file name.

The alarm list can be rearranged by clicking on the item name that is required as a reference for rearrangement.
In case that there are many files for the rearrangement, it may sometimes delay the performances of starting or
stopping recording on the VN-S400U while the rearrangement of the files.

With alarms that have been recorded in files (with which the recording file names shown in the {Recording file}
column), double-clicking on a recording file name plays back the image in the Play View Window.
(Pause at the time of an alarm)

1
2

3

4

Tree View Area Layout  [W] tab
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19-2. Menu Displayed by Right-clicking on Icons in the Tree View Area Layout

Large
Small
Hide

Sequential Stop
Zoom In

Zoom Out
Time Stamp Draw
Motion Grid Draw

Live View Window Setting
View Point Setting
View Point Control

Magnifies the View Window size by 1 step (320 x 240 or 640 x 480).
Reduces the View Window size by 1 step (320 x 240 or 160 x 120).
Hides the View Window.
Stop sequential display.
Zooms into the image.
Zooms out of the image.
Displays or hides the Time Stamp.
Displays or hides the motion grid color, motion area color and motion detect color.
Opens ‘Live View Window Setting’ dialog box.
Opens ‘View Point Setting’ dialog box.
Opens ‘View Point Control’ dialog box.

[Icons in the left-half section under the WP tab or icons under the W tab]

Right-click menu on Work Space icon
New Live View Window

Option

Right-click menu on Live View Window icon
Delete

Rename
Display

Live View Window Setting

Delete
Rename

Display
Play View Window Setting

Right-click menu on Play View Window icon

Delete
View Point Setting
View Point Control

Right-click menu on View Channel icon

Creates a new Live View Window.
Opens the ‘Option’ dialog box.

Deletes the Live View Window.
Changes the Live View Window name. (Within 32 characters)
Displays or hides the Live View Window.
Opens ‘Live View Window Setting’ dialog box.

Deletes the Play View Window.
Changes the Play View Window name. (Within 32 characters)
Displays or hides the Play View Window.
Opens ‘Play View Window Setting’ dialog box.

Deletes the View Channel.
Opens ‘View Point Setting’ dialog box.
Opens ‘View Point Control’ dialog box.

Right-click menu on the Play View Window (The setting subjects vary according to the model of the View Point.)
Large
Small
Hide

Open File
Close File

Time Stamp Draw
Motion Grid Draw

Play View Window Setting

Magnifies the View Window size by 1 step (320 x 240 or 640 x 480).
Reduces the View Window size by 1 step (320 x 240 or 160 x 120).
Hides the View Window.
Opens ‘Open’ dialog box.
Closes the file being displayed.
Displays or hides the Time Stamp.
Displays or hides the motion grid color, motion area color and motion detect color.
Opens ‘Play View Window Setting’ dialog box.

19. Right-click Menus and Keyboard Shortcuts
19-1. Menus Displayed by Right-clicking in View Windows

Right-click menu on the Live View Window (The setting subjects vary according to the model of the View Point.)



54

Rename
View Point Setting
View Point Control

[Icons in the left-half section under the WP tab or icons under the W tab]

Delete
Rename

New View Point Group
New View Point

Right-click menu on View Point Group icon

New View Point Group
New View Point

Option
Display IP Address

Right-click menu on Work Space icon

Right-click menu on external device icon

Right-click menu on View Point icon
Delete

Rename
View Point Setting
View Point Control

Right-click menu on View Channel icon
Rename

View Point Setting
View Point Control

Creates a new View Point Group under the Work Space.
Opens ‘New View Point’ dialog box.
Opens the ‘Option’ dialog box.
Displays or hides the IP address of the View Point icon and the Live View Window.
(If this setting is changed during recording, the View Channel will be recognized as
another view channel in its playback.)

Delete the View Point Group and View Points included in it.
Changes the View Point Group name. (Within 32 characters)
Creates a new View Point Group under the View Point Group.
Creates a new View Point in the View Point Group. Opens ‘New View Point’ dialog box.

Delete the View Point.
Changes the View Point name. (Within 32 characters)
Opens ‘View Point Setting’ dialog box.
Opens ‘View Point Control’ dialog box.

Changes the View Channel name. (Within 32 characters)
(If the View Channel name is modified during recording, the View Channel will be
recognized as another view channel in its playback.)
Opens ‘View Point Setting’ dialog box.
Opens ‘View Point Control’ dialog box.

Changes the extra device name. (Within 32 characters)
Opens ‘View Point Setting’ dialog box.
Opens ‘View Point Control’ dialog box.

Refresh
Delete All

Delete before yesterday
Delete before 7 days ago

Delete before 31 days ago

Refresh the Alarm list.
Delete all alarms
Delete the alarms received yesterday and before it.
Delete the alarms received 7 days ago and before it.
Delete the alarms received 31 days ago and before it.

Right-click menu on Alarm List icon

Refresh
Open File

Right-click menu on PC REC File icon
Refresh the list of the PC recorded files
Opens the ‘Open’ dialog box.
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19-3. Keyboard Shortcuts
The following keyboard shortcuts available in VN-S400U.

Ctrl + O
Ctrl + S
Ctrl + M
Ctrl + N

F2

Opens ‘Open’ dialog box.
Save the Work Space.
Opens ‘New View Point’ dialog box.
Opens ‘New View Window’ dialog box.
Modify the names.
Press [F2] key after selecting the desired icon in Tree View Area Layout.The follow-
ing icons are available.

Live View Window icon, Play View Window icon, View Point icon, View Point Group icon,
View Channel icon (In the right-half section under the WP tab or under the P tab),
External device icon
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20. Saving Work Space and Exiting

20-1. Saving and Exiting the Work Space
To save the work performed in a Work Space, open the [File] menu and select [Save Work Space]. This operation
saves all of the registrations that have been made, including those of the Live View Windows and View Points.
To exit a Work Space, open the [File] menu and select [Close Work Space].

20-2. Opening a Saved Work Space
To open a previously saved Work Space, open the [File] menu and select [Open Work Space].
When the [Open] dialog box appears, select the Work Space file (*.vxw) from its save location and click on the
[Open] button.

20-3. Closing Options
When the VN-S400U is going to be closed after editing the Work Space, VN-S400U confirms whether the Work
Space should be saved or not through the dialog box usually. By this option, it is possible to close VN-S400U after
saving the Work Space automatically, or without saving the Work Space automatically.
There are two ways to make this option enable. (Examples of Windows XP)

[1] By the shortcut icon:
Right-click on the shortcut icon of VN-S400U and choose [Properties]
from the pop-up menu.
Click on [Shortcut] tab, then add to the section “Linked to” like this;

<To close the Work Space with saving>
“C:\Program Files\JVC\VN-S400U\VNS400U.exe” /S

<To close the Work Space without saving>
“C:\Program Files\JVC\VN-S400U\VNS400U.exe” /-S

[2] By the association function of starting up the Work Space
(.vxw):
Open the Explorer. Choose [Folder options] from [Tool] menu, and click
on [File Types] tab.
Choose “VXW” (VXW File) from the list, then click on [Advanced].
Choose [open] at the “Actions” list, and click on [Edit].
Type on the “Application executed the action” like this;

<To close the Work Space with saving>
“C:\Program Files\JVC\VN-S400U\VNS400U.exe” “%1” /S

<To close the Work Space without saving>
“C:\Program Files\JVC\VN-S400U\VNS400U.exe” “%1” /-S

[VN-S400U Properties] dialog box



57

21. Operating Suggestions
For your convenient operation, please note the following subjects during the operation of VN-S400U.

Concerning settings of your PC :
During the operation of VN-S400U, keep your PC not to become ‘System standby’ or ‘Turn off hard disks’.
VN-S400U may malfunction or be closed if the PC turns to ‘System standby’ or ‘Turn off hard disks’.
The settings of 'System standby' and 'Turn off hard disks' are in the [Control Panel] > [Power Options Properties].

It may slow down the performance depending on the graphic board in use that the CPU is highly utilized because the
“Hardware acceleration” is set to “Full”. In such case, confirm the setting of “Hardware acceleration” by [Control
Panel] ( > [Appearance and Themes] ) > [Display] > [Settings] > [Advanced] > [Troubleshoot], and change the setting
to lower position by on level from the “Full” position.

Concerning the CPU load during VN-S400U’s running :
The following operations need higher CPU usage:

-Refreshing the Alarm list
-Displaying plural Play View Windows
-Deleting many recorded files at a time

These subjects possibly become the reasons of declining the recording frame rate.
Try to keep the CPU usage about 80 % or lower by reducing the number of View Windows, setting the frame rate
lower or displaying the image in small size.

Concerning the recordings :
If the View Window of MPEG-4 channel is hidden, it takes a few seconds to start recording from clicking the Rec
button. It is needed to display the View Window to start recording exactly, especially in case of alarm recording.

For multiple VN-S400U users :
On the occasion of the recording of MPEG-4 channel, the recording is stopped if the image size of the connected
View Point is changed by other VN-S400U. Please do not change the image size by other VN-S400U while one VN-
S400U is recording the MPEG-4 channel of the View Point.

For DM-NC40U users :
The image from DM-NC40U is stopped if the DM-NC40U settings are changed at the browser via network during the
viewing of the image. Please refrain from changing the settings of the DM-NC40U while its image is displayed or
recorded at the VN-S400U.

Concerning the modification of View Point Password :
VN-S400U may malfunction if the passwords of View Point equipment are changed by using the “Setup Tool” (For
V.Networks) or setting tools on the web (For V.Networks and DM-NC40U) under the connection. Refrain from modify-
ing the passwords at the View Point equipment during connecting with VN-S400U. Close the Work Space or finish
VN-S400U before modifying passwords of View Point equipment.

Concerning the disconnected View Points :
VN-S400U may malfunction if there are many disconnected View Points on the Work Space.

*

*

(continued on the next page)
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Concerning the recording file save location (hard disk drive) and file save period :

It is recommended to use a different disk drive for the recording file save location from the OS system's drive.
Additionally the NTFS is recommended for the file system of the disk drive which has the file save location. FAT/FAT32
may sometimes make the recording impossible because of its limitation of the number of files per a folder.

For the stable performance with recordings over the long term, defragment the disk drive regularly. Keep the disk drive
70% or less occupied by deleting old recording files using effectively the file save period setting. This operation also
avoids the fragmentation of the disk drive. (See '12-5. Setting the Recording File Save Period' about the file save period
setting.)

Concerning playing back files :
Note that the recording files should be closed after the playback by right-click on Play View Window and choose
[Close File]. The recording files in playing back can neither be deleted even if they are the target of the automatic
deletion nor other files in the same folder.

Concerning updating the recording file list or alarm list :
Avoid updating the lists during the hours that the alarm recording or timer recording must be started without any delay.
In case that there are recording files massively in the file save location, it may sometimes delay the performance of
starting alarm recording or timer recording during updating the recording file list by clicking [PC REC File] icon or
updating the alarm list by clicking [Alarm List] on the Tree View Area Layout.

*

*



is a registered trademark owned by Victor Company of Japan, Limited.

is a registered trademark in Japan, the U.S.A., the U.K. and many other countries.

2003-2004 Victor Company of Japan, Limitedc


	Cover
	Precautions
	Table of Contents
	1.Introduction
	1-1.Main Functions of VN-S400U
	1-2.Differences of the previous versions

	2.VN-S400U Startup
	2-1.Glossary
	2-2.Starting the VN-S400U

	3.Let's Try
	4.Image Viewing(Live Image Viewing)
	4-1.Creating a New Work Space
	4-2.Opening a Live View Window
	4-3.Registering a View Point
	4-4.Viewing the Image of a View Point
	4-5.Exclusive Registration Mode
	4-6.Output the Sound of All View Windows

	5.Control of a Live Image
	5-1.Using the Live Controller
	5-2.VN-C2U/C3U/C30U Controller
	5-3.Setting the Position Memory
	5-4.External Device Controller

	6.Recording an Image from a View Channel
	6-1.Recording and Using the Live View Controller
	6-2.Deleting a Recorded File

	7.Timer Recording
	8.Playback of a Recording
	8-1.Playing Back a PC Recorded File
	8-2.Playing Back a Local Recorded File

	9.Control of a Playback Image
	9-1.Using the Playback Controller
	9-2.Clipping and Saving a File (For only REC files)

	10.Snap Shot
	11.Alarm Setup
	11-1.Alarm Setting Procedure
	11-2.Setting the Operation Upon Alarm Reception

	12.Option Setup
	12-1.Setting the Tree View Area Layout
	12-2.Showing/Hiding the IP addresses
	12-3.Highlighting the View Window
	12-4.Setting the Priority of the Primary Window
	12-5.Setting the Recording File Save Period
	12-6.Setting the Password for the Work space (Default Password)
	12-7.Protect Mode
	12-8.Setting the E-Mail Sending Address Upon Alarm Reception

	13.Live View Window Setup
	13-1.Changing the View Window Name and Its Display Size
	13-2.Motion Detection Display
	13-3.Setting Sequential Interval
	13-4.Setting the REC Indication
	13-5.Setting the Connected View Point Information Display
	13-6.Setting the Time Stamp Display
	13-7.Setting the Alarm Message Display Colors
	13-8.Setting the Recording File Save Location
	13-9.Starting REC automatically by Opening the Work Space
	13-10.Timelapse Recording
	13-11.Alarm Recording

	14.Play View Window Setup
	14-1.Changing the View Window display Size
	14-2.Motion Detection Display
	14-3.Playback Mode Indcation
	14-4.Setting the Recording View Point Information Display
	14-5.Setting the Time Stamp Display

	15.View Point Setup
	15-1.Changing the View Point Name
	15-2.Setting the Password for a View Point (DM-NC40U)
	15-3.Setting the Password for a View Point (V.Networks)
	15-4.Setting the Connection Port
	15-5.Setting the View Point Image (DM-NC40U)
	15-6.Setting an External Device
	15-7.Setting the View Point Image (V.Networks)
	15-8.Setting an External Device

	16.Primary Window
	17.Load Pattern of the View Windows
	17-1.Registering the View Window Load Pattern
	17-2.Displaying View Windows in a Registered Pattern
	17-3.Display/Hide All View Windows

	18.Tree View Area Layout Operations
	18-1.Displaying an Image in a Live View Window
	18-2.Creating a View Point Group
	18-3.Playing Back a PC Recorded File
	18-4.Playing Back a Local Recorded File
	18-5.Displaying the Alarm List
	18-6.Deleting Registered Items

	19.Right-click Menus and Keyboard shortcuts
	19-1.Menus Displayed by Right-clicking
	19-2.Menus Displayed by Right-clicking on Icons in the Tree View Area Layout
	19-3.Keyboard Shortcuts

	20.Saving Work space and Exiting
	20-1.Saving and Exiting the Work Space
	20-2.Opening a Saved Work Space
	20-3.Setting the Closing Options

	21.Operating suggestions
	Back cover



